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Introduction

Introduction
Thank you for purchasing the Canon S330 Bubble Jet Printer. This User’s Guide provides 
complete explanations of the features and functions of the printer. 
This guide uses the following symbols to indicate important information. Always observe 
these instructions.

Warning ➤ Instructions that, if ignored, could result in death or serious personal injury 
caused by incorrect operation of the equipment.
These must be observed for safe operation.

Caution ➤ Instructions that, if ignored, could result in personal injury or material 
damage caused by incorrect operation of the equipment. 
These must be observed for safe operation.

Important ➤ Prohibited actions that, inadvertently performed, could result in equipment 
damage, faults or impaired product quality.
These must be observed for safe operation.

Information for Windows® users only.

Information for Macintosh® users only.

Windows

Macintosh
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How to Use This Manual

How to Use This Manual
To view this User’s Guide, we recommend that you use Acrobat® Reader™ 4.0 or Acrobat 
Reader 3.0. Please note that screens displayed by Acrobat Reader 3.0 are slightly different.

Use this button to enlarge the 
viewing screen. Select this button in 
the tool bar and click within the 
screen. Displays the next page.

Returns to the 
page you were 
previously 
viewing.

Click to jump straight to 
this page.

Displays the previous page.
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How to Use This Manual

Displays the table of contents. 
Click the heading to jump to the topic.

Click the " " symbol to see the headings for each chapter.

Click the " " symbol to close the headings.

Use this button 
to search for a 
word.
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Safety Precautions

Safety Precautions
Please read the safety warnings and cautions provided in this manual to ensure that you 
use the printer safely. Do not attempt to use the printer in any way not described in this 
manual.

Warning ➤ You may cause an electric shock/fire or damage the printer if you ignore 
any of these safety precautions.

■ Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

■ Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands 
are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the 
power cord. Do not place heavy objects on the power cord.
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Safety Precautions

Never plug the printer into a power socket that is shared with other 
equipment (extension cord, double adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately 
unplug the printer at the power supply and call for service.

Periodically unplug the printer and use a dry cloth to wipe off any 
dust or dirt that has collected on the plug and power outlet. If the 
printer is placed in a location exposed to a lot of dust, smoke or high 
humidity, the dust that has collected on the plug may absorb 
moisture and cause insulation failure and fire.

■ Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents 
such as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the 
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the printer.
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Safety Precautions

■ Maintaining the printer

Do not attempt to disassemble or modify the printer. There are no user-serviceable parts 
inside the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not described in 
this guide.

■ Working around the printer

Do not use flammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical components inside 
the printer.
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Safety Precautions

Caution ➤ You may cause injury or damage the printer if you ignore any of these 
safety precautions.

■ Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, 
outdoors, or close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient temperature range 
of 41°F to 95°F (5°C to 35°C) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times 
so you can easily unplug the power cord if necessary.

When moving the printer, carry the printer at both ends.
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Safety Precautions

■ Power supply

Never remove the plug by pulling on the cord.

Do not use an extension cord.

If you intend to not use the printer for a long period of time, unplug it after turning it off.

Never use a power supply voltage other than that supplied in the country of purchase.

The correct power supply voltage and frequency is as follows:
USA/Canada: AC 120V, 60Hz
Europe: AC 230V±10%, 50Hz
Australia: AC 240V, 50Hz



13

Safety Precautions

■ Working around the printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable 
solvents (alcohol, thinners. etc.) on top of the printer.

If any foreign object (metal or liquid) falls into the printer, unplug the power cord and call 
for service.

■ Print heads and ink tanks

For safety reasons store print heads and ink tanks out of the reach of small children.

If a child ingests any ink, consult a doctor immediately.

Do not shake print heads or ink tanks.

Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a print head after printing.

The metal parts may be very hot and could cause burns.
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Printer Parts and Their Functions

Printer Parts and Their Functions

• Front View

• Rear View

• Inside the Printer

• Operation Panel
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Printer Parts and Their Functions

Front View

Paper Guide
When loading paper, ensure 
that the left edge touches 
this guide.
To move the paper guide, 
pinch the guide and slide in 
the appropriate direction.

Paper Rest

Sheet Feeder
Load paper here. 
Paper feeds 
automatically, one sheet 
at a time.

Front Cover
Open to replace the 
ink tanks or remove 
jammed paper.

Paper Output Tray

Operation Panel
For details, refer to 
"Operation Panel." 



Rear View 16

Printer Parts and Their Functions

Rear View

USB Port
Connects the printer to a 
computer through a USB port.
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Printer Parts and Their Functions

Inside the Printer

Print Head Lock Lever
Locks the print head into the holder. 
Once the print head is installed, do not touch this lever.

Paper Thickness Lever
Adjusts the gap between the print head and the surface 
of the printing paper.

Print Head Holder
Install the print head here.
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Printer Parts and Their Functions

Operation Panel

POWER Button
Press to turn the printer 
on or off. The printer will 
initialize, then print.

RESUME/CANCEL Button
Press to resume printing once an error has 
been resolved. To cancel printing in 
progress, press this button.

POWER Lamp
Off: The printer is turned off.
Green: The printer is ready to print.
Flashing green: The printer is preparing to print, or is currently printing.
Flashing orange: An error has occurred and the printer is not ready to print.
Flashing orange and green alternately: An error has occurred that may 
require a service call.
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Printer Driver Functions (Windows)

Printer Driver Functions (Windows)

• Opening the Printer Properties Dialog Box

• Printer Properties Dialog Box Description

• BJ Status Monitor Functions

• Canceling a Print Job

• Uninstalling Printer Drivers
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Printer Driver Functions (Windows)

Opening the Printer Properties Dialog Box

The Printer Properties dialog box can be opened either from within an application or directly 
from the Windows Start menu.

■ Opening the Printer Properties dialog box from your application program

This method is generally used to specify printer settings just before printing.
The operations may vary slightly depending on your application program. This section 
describes only the general procedure for opening the Printer Properties dialog box. 

1 In your application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File 
menu.

2 Ensure that Canon S330 is selected in the Name field, then click 
Properties.

The Printer Properties dialog box will open. 

Note ➤ Depending on your application program, the command and menu names 
may differ, and there may be more steps involved in opening the Printer 
Properties dialog box. For further details, see the user's manual for your 
application. 
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Printer Driver Functions (Windows)

■ Opening the Printer Properties dialog box directly from the Start menu

This method is used for maintenance operations such as print head cleaning, or to 
specify printer settings common to all application programs.
When the Printer Properties dialog box is opened from the Start menu, additional tabs 
appear, including the Details tab. These do not appear when the Printer Properties 
dialog box is opened from within an application. 
For further information about these additional tabs, refer to your Windows 
documentation.

1 Click the Start button, then select Settings, Printers.

For Windows XP, click Start and select Control Panel, Printers and Other 
Hardware, then Printers and Faxes.

2 Select the Canon S330 icon.

3 Open the File menu and select:
• Windows 98/Windows Me ➔ Properties
• Windows 2000/Windows XP ➔ Printing Preferences...

The Printer Properties dialog box will open. 
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Printer Driver Functions (Windows)

Printer Properties Dialog Box Description

Note ➤ The screens in this section refer to Windows 98/Windows Me operation. 
The equivalent screens for Windows 2000 and Windows XP may look 
slightly different.

• Main Tab
• Page Setup Tab
• Stamp/Background 

Tab

• Effects Tab
• Profiles Tab

• Maintenance Tab
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Printer Driver Functions (Windows)

Main Tab

(1) Media Type 
Ensure that this setting matches the type of media loaded in the printer. 

(2) Print Quality 
Select the print quality you require from among the different options. To use a custom 
Print quality, select Custom, then click the Set... button. 

(6)

(4)

(1)

(2)

(3)

(5)
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Printer Driver Functions (Windows)

(3) Color Adjustment 
Select the method of color adjustment. To make detailed color adjustments, select 
Manual, then click Set. 

(4) Grayscale Printing 
Select to print a grayscale version of a color document. 

(5) Preview before printing
Before printing, select the check box to preview the layout and verify that settings are 
correct.

(6) Print Advisor... 
Click to start the Print Advisor. 
The Print Advisor simplifies configuration of the printer driver. By having the user 
answer a series of questions, the Print Advisor automatically configures the printer 
driver settings.

Note ➤ To see a description of any item in the Printer Properties dialog box, click 
the ? mark, then click the desired item. To see a description of operating 
procedures, click Help. If Help does not appear when using Windows 2000 
or Windows XP, click Start, then select Programs (or All Programs), then 
Canon S330, then Guide.
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Printer Driver Functions (Windows)

Page Setup Tab

(1) Page Size 
Ensure that the correct paper size is selected.

(2) Orientation 
Select landscape or portrait printing and ensure that it is the same orientation used in 
the application. 

(2)

(1)

(3)

(7)
(8)

(6)

(4)
(5)
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Printer Driver Functions (Windows)

(3) Printing Type 
Select the printing method from among the following:

Normal-size Printing The document is printed according to the original 
dimensions. This setting is usually selected by default. 

Fit to Page Printing The document is automatically resized and printed to fit into 
a specified page size.

Scaled Printing The document is resized when printed. When this is 
selected, you can specify the Printer Paper Size and 
Scaling.

Page Layout Printing Pages are reduced and printed so that multiple document 
pages fit on each printed page.

Booklet Printing The multi-page document is printed so that two pages of the 
document fit on each printed page. The print order is set 
automatically. After the document is printed, you can create 
a booklet by folding and saddle-stitching the document.

Poster Printing This enlarges and splits the print image across several 
sheets of paper. The printed sheets can then be assembled 
to make a large poster.

Banner Printing Select this when printing on banner paper.
(4) Borderless Printing 

The image is printed on the entire paper surface, so that no margins are left on the 
four sides of the paper. The media types available for Borderless Printing are Photo 
Paper Pro, Glossy Photo Paper, Photo Paper Plus Glossy and Matte Photo Paper. For 
all other media types, the print quality may decrease when borderless printing is 
selected.
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Printer Driver Functions (Windows)

(5) Amount of Extension 
When you select Borderless Printing, the sections that extend beyond the paper are 
not printed because the image is enlarged to a size slightly larger than the paper size. 
You can use the slider to adjust how much the image extends beyond the paper. It is 
recommended that you normally set the slider to the right end. If you move the slider 
to the left to reduce the extension amount, a border may appear.

(6) Duplex Printing
The document is printed on both sides of the paper. After printing one side, turn the 
ejected page over and print on the other side.

(7) Reverse order 
Prints the document starting with the last page. 

(8) Collate 
Select to print multiple copies of the document one copy at a time.
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Printer Driver Functions (Windows)

Stamp/Background Tab

(1) Stamp 
Select the check box, then choose a stamp. 

(2) Place stamp over text 
When Stamp is selected, you can select this check box. When selected, the stamp is 
printed over the print data.

(1)

(2)
(3)

(4)

(5)

(6)
(7)
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Printer Driver Functions (Windows)

(3) Stamp first page only 
When Stamp is selected, you can select this check box. When selected, the stamp is 
printed only on the first page. 

(4) Define Stamp... 
This allows you to create new stamps, or modify the selected stamp. 

(5) Background 
Select the check box, then choose the background image you wish to use. 

(6) Background first page only 
When Background is selected, you can select this check box. When selected, the 
background image is printed only on the first page. 

(7) Select Background... 
This allows you to select a new background, or display details of the background you 
have selected. 
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Printer Driver Functions (Windows)

Effects Tab

(1) Simulate Illustration 
This function lets you apply graphic effects to a color image without affecting the 
original document. Select the check box, then adjust the image brightness with the 
Contrast slider.

(1)

(2)

(5)

(3)

(4)



Printer Properties Dialog Box Description 31

Printer Driver Functions (Windows)

(2) Monochrome Effects 
Prints a color image in a single color. Select the check box, then choose a color or use 
a custom color using Select Color.

(3) Vivid Photo
With this function, you can reproduce breathtaking sceneries in which colors, 
especially blues and greens, appear even more vibrant. A major feature of this 
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky while 
maintaining the natural skin tones of people who appear in the images.

(4) Image Optimizer 
Improves the contours and smooths jaggedness that occurs when photographic or 
graphic image data is enlarged within an application.

(5) Photo Optimizer PRO 
Optimizes the color for images taken from a digital camera or scanner. It is especially 
effective for images affected by color imbalance and over- or under-exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut-and-paste, rotation or other such operations, group 
optimization of all images on the page is recommended. In such cases, select the 
Apply Throughout Page check box. 
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Printer Driver Functions (Windows)

Profiles Tab

(1) Printing Profiles 
This list displays the printing settings currently registered in the Profiles tab.
The Current Settings profile contains the settings currently specified in the Main, 
Page Setup, Stamp/Background and Effects tabs. The Default Settings profile 
contains the factory default settings.

(1)

(4)

(2)

(3)

(6)

(5)
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Printer Driver Functions (Windows)

(2) Details 
Displays all the printer settings selected in Printing Profiles.

(3) Description 
Displays a description of the printer settings selected in Printing Profiles. You can 
enter the description when saving the printer settings. 

(4) Add to Profiles... 
Click to save the settings currently specified in the Main, Page Setup, Stamp/
Background and Effects tabs. Select Current Settings in the Printing Profiles list, 
then click this button. The Add to Profiles... dialog box will appear.

(5) Retrieve from Profiles 
Click to activate the registered printer settings. The contents of the Main, Page Setup, 
Stamp/Background and Effects tabs are changed by selecting the printer settings in 
Printing Profiles, then clicking this button. This button is disabled when Current 
Settings is selected.

(6) Delete 
Click to delete unwanted printer settings. Select the unwanted item in the Printing 
Profiles list, then click Delete. Current Settings and Default Settings cannot be 
deleted.
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Printer Driver Functions (Windows)

Maintenance Tab

(1) Cleaning 
Click to start print head cleaning.

(2) Deep Cleaning 
Click to start print head deep cleaning.
Use this function only if Cleaning has not improved the print quality.

(1)

(2)

(7)

(5)

(10)

(11)

(6)(3)

(4)

(8)

(9)
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Printer Driver Functions (Windows)

(3) Print Head Alignment 
Click to start the print head alignment process. For details on print head alignment, 
refer to the printed Quick Start Guide.

(4) Nozzle Check 
Click to start a nozzle check print pattern. The nozzle check ensures that print head 
nozzles are outputting ink normally. For details, refer to “Examining the Nozzle Check 
Pattern”.

(5) Power Off 
Click to turn the printer off.

(6) Auto Power 
This allows you to turn the printer off when no data is sent to the printer for a certain 
period of time, or turn the printer back on again when data is sent to the printer.

(7) Ink Counter Reset 
Resets ink counter to an initial value. Click if you did not select Yes when a 
confirmation message of ink tank replacement appeared after installing a new ink 
tank.

(8) Low Ink Warning Setting 
Click to set alerts, such as Low ink warning, or Ink tank replacement.

(9) Custom Settings... 
Click to modify the printer mode. Change the settings in the Custom Setting dialog 
box, then click Send to change the printer mode.

(10) Quiet Mode 
Click to reduce the printing noise. You can also use this feature to set the time during 
which Quiet Mode is to be used. However, the effect may be small, depending on the 
print quality setting. If you use Quiet Mode, the print speed may be slower than 
normal.
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Printer Driver Functions (Windows)

(11) Start Status Monitor 
Click to start the BJ Status Monitor, which checks and reports the printer status and 
the progress of printing jobs. 
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Printer Driver Functions (Windows)

BJ Status Monitor Functions

The BJ Status Monitor allows you to check the status of the printer. 
If an error occurs, the status monitor indicates the nature of the error and suggests an 
appropriate solution. When the low ink warning is enabled, the status monitor also checks 
the ink tanks and displays a warning message when ink is low.

■ Launching the BJ Status Monitor

The BJ Status Monitor launches automatically when data is sent to the printer. When 
launched, the BJ Status Monitor will appear as an icon on the taskbar. 

1 Click the Canon BJ Status Monitor icon on the taskbar.

The BJ Status Monitor will appear.
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Printer Driver Functions (Windows)

Note ➤ To open the BJ Status Monitor when the printer is not printing, click the 
Maintenance tab in the Printer Properties dialog box, then click Start 
Status Monitor.
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Printer Driver Functions (Windows)

■ When errors occur

The BJ Status Monitor is automatically displayed when an error occurs, such as if the 
printer runs out of paper or if the paper jams.
In such cases, take the appropriate action as described in the Printer Status tab.
In Windows 98 and Windows Me, click the Guide tab and follow the instructions on 
screen.

Note ➤ For details on the BJ Status Monitor, click the Help menu, then click the 
topic of interest.

When paper has run out:
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Printer Driver Functions (Windows)

Canceling a Print Job

To cancel the current print job, first open the BJ Status Monitor. 

1 Click the Canon BJ Status Monitor icon on the taskbar.

2 Click Cancel Printing.

Note ➤ If Cancel Printing is grayed out, press the printer's RESUME/CANCEL 
button to terminate the print job. 
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Printer Driver Functions (Windows)

Uninstalling Printer Drivers

Use the Uninstaller to delete the printer driver. The Uninstaller will delete all the files 
associated with the printer driver.

1 Click Start, then select Programs, Canon S330, Uninstall.

For Windows XP, click Start, then All Programs, then Canon S330, then 
Uninstall.

2 Click Yes when the confirmation message appears.

3 When all the files have been deleted, click OK.

The deletion of the printer driver is complete.

If a message prompts you to restart your computer, click OK.

Note ➤ In Windows 98 or Windows Me, you can also start the Uninstaller by 
double-clicking on Uninstall in the Canon S330 folder on the desktop.
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Printer Driver Functions (Macintosh)

Printer Driver Functions (Macintosh)

• Description of Print Settings

• BJ Print Monitor

• Canceling a Print Job

• Using the Printer with a Network

• Uninstalling Printer Drivers
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Printer Driver Functions (Macintosh)

Description of Print Settings

• Page Setup Dialog Box

• Printer Utility 
Dialog Box

• Print Dialog Box

• Options Dialog Box
• Register Settings 

Dialog Box

• Detailed Setting Dialog 
Box
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Printer Driver Functions (Macintosh)

Page Setup Dialog Box

The Page Setup dialog box contains settings for the printed page, such as the size of the 
print media used and the image printed. To open the Page Setup dialog box, select Page 
Setup from the File menu in your application program. 

(1) Paper Size 
Select the size of the paper for the print job. To enter the size manually, select 
Custom 1 - Custom 3, then click Custom. 

(2) Banner Printing 
Select this check box when printing on banner paper.

(1)

(2)
(7)

(5)

(8)

(6)

(9)

(4)
(3)
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Printer Driver Functions (Macintosh)

(3) Borderless Printing 
The image is printed on the entire paper surface, so that no margins are left on the 
four sides of the paper. The media types available for Borderless Printing are Photo 
Paper Pro, Glossy Photo Paper, Photo Paper Plus Glossy and Matte Photo Paper. For 
all other media types, the print quality may decrease if borderless printing is selected.

(4) Amount of Extension 
When you select Borderless Printing, the sections that extend beyond the paper are 
not printed because the image is enlarged to a size slightly larger than the paper size. 
You can use the slider to adjust how much the image extends beyond the paper. It is 
recommended that you normally set the slider to the right end. If you move the slider 
to the left to reduce the extension amount, a border may appear.

(5) Scale 
Specify the scaling percentage to resize the document for printing.

(6) Orientation 
Select landscape or portrait printing. 

(7) Custom 
To specify a custom paper size, select Custom 1 to Custom 3 from the Paper Size 
pop-up menu (1), then click this button to open the Custom dialog box. In the Custom 
dialog box, specify the length and width of the paper.

(8) Utilities 
Click to open the Printer Utility dialog box for maintenance operations such as print 
head cleaning and nozzle check pattern printing, as well as for changing the print 
mode. 

(9) Save Settings 
Saves the settings specified in the Page Setup dialog box.
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Printer Driver Functions (Macintosh)

Printer Utility Dialog Box

The Printer Utility dialog box is displayed when you click the Utilities button in the Page 
Setup dialog box.

(1) Select the function you wish to perform: Cleaning, Test Print, Remaining ink level 
setting, Auto Power, Quiet Mode or Custom Settings.

(2) Display area showing the various maintenance functions, including cleaning and test 
pattern printing. Click the icon to start this function. For further details, refer to 
"Routine Maintenance". 

(1)

(2)
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Printer Driver Functions (Macintosh)

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

➡ Print Head Deep Cleaning

➡ How Low Ink Warning Setting Works

Note ➤ For information about print head alignment, refer to the printed Quick Start 
Guide. 
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Printer Driver Functions (Macintosh)

Print Dialog Box

The Print dialog box specifies the media type and print settings to be used for your print job. 
To open the Print dialog box, select Print from the File menu in your application program. 

(1) Options... 
Specify the output destination, print order and page layout for the document you are 
printing. 

(2) Apply... 
Allows you to register print settings or to implement a previously registered print 
setting. 

(3) Media Type 
Ensure this setting matches the type of paper media loaded in the printer. 

(1)
(2)

(3)

(4)

(5)(6)



Description of Print Settings 49

Printer Driver Functions (Macintosh)

(4) Details... 
Allows you to manually set the print quality and color settings in the Detailed Setting 
Dialog Box. (This option is only available if Manual print mode is selected.)

(5) Print Mode 
Select the icon that most closely resembles your document and required print results.

(6) Grayscale Printing 
Click to print a grayscale version of a color document.
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Printer Driver Functions (Macintosh)

Detailed Setting Dialog Box

To open the Detailed Setting dialog box, click Manual  in the Print dialog box, then click 
Details.

■ Quality panel

(1) Panel display icons
Click these icons to switch between panels in the Detailed Setting dialog box.

(1)
(2)

(3)
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Printer Driver Functions (Macintosh)

(2) Print Quality 
Move the slider to adjust the balance between print quality and speed. Moving the 
slider to the right enhances print quality, and moving it to the left increases printing 
speed.

(3) Halftoning 
Select either Dither or Diffusion ink dot configurations. 
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■ Special Effects Panel

To display the Special Effects panel, click the Special effects display icon. 

(1) Simulate illustration 
This function lets you apply graphic effects to a color image without affecting the 
original document. Select the check box, then adjust the brightness of the image with 
the Contrast slider.

(1)

(2)

(3)

(4)
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(2) Monochrome effects 
Prints a color image in a single color. Select the check box, then choose a color, or 
use a custom color using Select Color.

(3) Vivid Photo
With this function, you can reproduce breathtaking sceneries in which colors, 
especially blues and greens, appear even more vibrant. A major feature of this 
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky, 
while maintaining the natural skin tones of people who appear in the images.

(4) Photo Optimizer PRO
Optimizes the color for images taken from a digital camera or scanner. It is especially 
effective for images affected by color imbalance and over- or under- exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut and paste, rotation or other such operations, group optimization 
of all images on the page is recommended. In such cases, select the Apply 
Throughout Page check box. 
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■ Color Panel

To display the Color panel, click the Color display icon. 

(1) Color Correction
Select a color correction method: BJ Standard, ColorSync or None. BJ Standard is 
usually the optimum color correction method for printing with a BJ printer. When 
ColorSync is selected, you should also specify the Print Type and Printer Profile 
settings.

(1)
(2)
(3)
(4)

(5)

(6)
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(2) Print Type 
For printing that emphasizes intermediate colors, select Photo. For printing that 
emphasizes the brightness of primary colors, select Graphics. For documents that 
contain large amounts of a single color, select Spot Color.

(3) Printer Profile 
Select optimized color characteristics (a profile) for the media type and other factors. 

(4) Gamma Correction 
This function adjusts the contrast on colors other than black and white. To adjust the 
contrast, select the check box, then move the slider. Moving the slider to the right 
darkens the entire image while increasing contrast in the lighter areas and decreasing 
contrast in the darker areas.

(5) Color Balance
Move the slider for each color to adjust the balance of color intensity. Moving the slider 
to the right intensifies the color.

(6) Intensity 
Move the slider to adjust the print intensity. Moving the slider to the right increases the 
density. 
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Options Dialog Box

To open the Options dialog box, click Options... in the Print dialog box.

(1) Layout 
Use this function to print more than one page on a single sheet of paper. Typically, this 
is set to 1 Page/Sheet Printing. If another option is selected, Page Order and Border 
can be specified.

(1)

(4)

(2)

(5)
(6)

(3)
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2 Page/Sheet Printing/4 Page/Sheet Printing
Pages are reduced and printed so that two or four pages fit on each printed page. 
You can also select page order and whether to place a border around each page.

Poster (Divided into 4) / (Divided into 9) / (Divided into 16) 
These enlarge and split the print image across several sheets of paper. The printer 
sheets can then be assembled to make a large poster. You can also select Cut/
Paste lines and Cut/Paste string. To print only the certain pages, click the specific 
pages on the preview area.

(2) Duplex Printing
The document is printed on both sides of the paper. After printing one side, turn the 
ejected page over, and print the other side.

(3) Fit-to-page Printing 
Executes scaled printing automatically. When selected, you can specify the Printer 
Paper Size. This fits the document paper size set in the application to the selected 
paper size.

(4) Destination 
Select the print output destination. Printer is the usual selection. To check the layout 
or other image elements before printing, select Preview. To save the document as a 
PICT file, select PICT File.

(5) Print in reverse order 
Prints the document starting with the last page. 

(6) Print collated pages 
Prints multiple copies of the document one copy at a time. 
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Register Settings Dialog Box

To open the Register Settings dialog box, click the Apply... button in the Print dialog box.

(1) Settings 
Displays a list of the registered print settings.

(2) Defaults 
Restores the print settings selected in Settings to defaults. A check mark appears 
next to the selected print settings.

(3) Import 
Imports a set of print settings. To use the settings, select the desired settings in the 
Settings list, then click the Import button.

(4) Apply 
Saves the settings currently specified in the Print dialog box. After clicking the button, 
enter the name under which the settings are to be saved. 

(5) Remove 
Deletes unwanted print settings. To delete unwanted settings, select the settings in 
Settings and click the Remove button. 

(1)

(4)
(5)

(2)

(3)



BJ Print Monitor 59

Printer Driver Functions (Macintosh)

BJ Print Monitor

The BJ Print Monitor allows you to check the progress of print jobs. 
You can launch the BJ Print Monitor if background printing is enabled in the Chooser utility.

■ Opening the BJ Print Monitor

1 Select Chooser from the Apple Menu.

2 Set Backgrounding to On.

3 After starting a print job, select BJ Print Monitor in the Application Menu. 

The BJ Print Monitor launches.
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■ BJ Print Monitor Functions

The BJ Print Monitor allows you to change the print order of documents queued for printing.
To change the print order, place the mouse pointer over the name of the document, hold the 
mouse button down while dragging the document name to the new position, then release. 
When the print order change includes the current job, it stops and the new job immediately 
starts instead.

... Click to pause printing of the specified document.

... Click to resume printing.

 ... Click to cancel printing of the specified document.

Displays the printer status. If an error occurs, instructions on what to 
do are displayed.
Displays the printer status and ink status with images.

Displays information about the documents queued for printing. 
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Canceling a Print Job

When the BJ Print Monitor is running, you can use it to cancel or suspend the current print 
job.

1 Select BJ Print Monitor in the Application Menu. 

2 Click the name of the print job you wish to cancel, then click .

The document selected in the Print Monitor is deleted from the print list and 
the print job is canceled. 

Note ➤ To suspend printing, click the name of the document being printed, then 
click . To resume printing, click . 
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Using the Printer with a Network

The printer can be used with an Ethernet network environment. Follow the steps described 
below to connect the printer to the network. 

■ Before Setting up the Printer

Install the printer driver on each network computer that will use the printer.
For information on installation, refer to the printed Quick Start Guide.

■ Printer Setup

To use the printer on a network, first set up the print server, then set up each client 
machine.

• Print server setup procedure

1 Select Chooser in the Apple Menu.

2 Select Active in AppleTalk.

3 Select the S330 icon, then select the printer name in Connected to:.
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4 Click Share.

5 Confirm that S330 server is selected in Enter new print server name: 
then click Send. 

6 Confirm that the new print server name has been added to Current print 
servers, then click Close.

7 Click the close box to close the Chooser.

• Client setup procedure

1 Select Chooser in the Apple Menu.

2 Select Active in AppleTalk.

3 Select the S330 (Server) icon, then select the printer server in Connected 
to:.

4 Click the close box to close the Chooser.
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■ Checking Print Status

• Checking print status from the print server
To check the status of a print job from the print server, start the BJ Print Monitor. 
Select BJ Print Monitor in the Application Menu.
To close the BJ Print Monitor, select Close Status Window in the File menu.

• Checking print status from a client
To check the status of a print job from a client, start the BJ Status Monitor. Click the BJ 
Status Monitor icon in the BJ Extras folder.
To close the BJ Status Monitor, select Quit in the File menu.

• The BJ Print Monitor and BJ Status Monitor
The BJ Print Monitor and the BJ Status Monitor both display a list of information 
concerning documents queued for printing. This information includes the document 
name, number of pages, number of copies and the time when the print job was 
accepted. The total number of queued documents is also displayed. 
The BJ Print Monitor allows you to change the print order of the queued documents.

➡ BJ Print Monitor Functions

➡ BJ Status Monitor Functions
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■ BJ Status Monitor Functions

....Click to pause printing of the specified document. 

....Click to resume printing. 

....Click to cancel printing of the specified document.

Note ➤ • You can determine the owner of a computer by selecting the File Sharing 
control panel and checking the Owner Name item.

• If you are using two or more printer servers, you can switch between the 
BJ Status Monitor displays. Select Print Server in the File menu, then 
select the desired print server and click OK.
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Uninstalling Printer Drivers

When a printer driver is no longer needed, use the Installer to delete all the program files 
associated with it at the same time.

Before proceeding, ensure you save any unsaved files in any currently running applications. 

1 Load the Setup Software & User's Guide CD-ROM.

2 Double-click the Printer Driver folder.

3 Double-click the Installer icon.

4 When the Software License Agreement is displayed, click Accept. 

5 Select Uninstall from the popup menu, then click Uninstall.

Note ➤ If a warning message appears indicating that other applications are 
running:
• Click Cancel and save the document(s) if there are any unsaved 

documents open in the other applications.
• Click Continue to continue the uninstall operation.

6 After the uninstall is complete, a message appears prompting you to restart 
your computer. Click Restart. 
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• When to Replace Ink Tank and Maintain Print Head

• Replacing an Ink Tank

• Resetting the Ink Counter

• How Low Ink Warning Setting Works

• Printing the Nozzle Check Pattern

• Print Head Cleaning

• Print Head Deep Cleaning

• How Low Ink Warning Setting Works

• Transporting the Printer
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When to Replace Ink Tank and Maintain Print Head

When printing becomes faint or colors are incorrect, see if the print head nozzles are 
clogged and clean them first. Follow the procedures below and replace an ink tank if 
necessary.

➡ Printing the Nozzle Check Pattern

If the print quality is poor

➡ Print Head Cleaning

If the problem remains

➡ Print Head Deep Cleaning

Still the problem remains

➡ Replacing an Ink Tank

If ink tank replacement does not resolve the problem, the print head may be worn out. 
Contact the Customer Care Center.
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Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully. The printer will not print 
properly if the wrong ink tank is used, or if an ink tank is installed in the incorrect position.

• Black: BCI-24 Black
• Color: BCI-24 Color

Note ➤ Damage caused by using a refilled cartridge is not covered by the Canon 
warranty. Canon recommends using only original Canon ink tanks to 
ensure the best quality.

1 Ensure that the printer is on, then open the front cover.

The print head holder moves to the left.
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2 Remove the empty ink tank.

Pull the tab on the ink tank toward you to release.

Lift the ink tank from its slot.

Do not touch the lock lever; remove only the ink tank.

Important ➤ • Handle ink tanks carefully to avoid staining clothing or the surrounding 
area.

• Discard empty ink tanks according to the local laws and regulations 
regarding disposal of consumables.

color black
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3 Unpack the new ink tank and remove the orange protective cap.

Important ➤ • Do not re-attach the protective cap once you have removed it. 
• To avoid spilling ink, do not touch the bottom of an ink tank once you have 

removed the protective cap. 
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4 Insert the ink tank into the empty slot.
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5 Press the tab until the ink tank snaps firmly into place.

6 Close the front cover.

The print head holder moves to the right. The ink tank installation process 
is now complete.

Note ➤ • To maintain optimal print quality, use an ink tank within six months of first 
use.

• Once an ink tank has been used, do not remove it from the printer and 
leave it out in the open. This will cause the ink tank to dry out and the 
printer may not function properly if it is reinstalled.

• Reset the ink counter every time you replace the ink tank.

➡ Resetting the Ink Counter
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Resetting the Ink Counter

When an ink tank is replaced, the ink counter must be reset. The low ink warning will only 
work properly if the ink counter is reset.

➡ How Low Ink Warning Setting Works

■ Ink Counter Reset

When the front cover has been open for a certain period, a confirmation message of ink 
tank replacement is displayed before the next print job.

Windows

1 Check the message, then click Yes.

2 Select the replaced ink tank, then click OK.

Note ➤ When both black and color ink tanks have been replaced, select both 
Black and Color.
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Macintosh

1 Check the message, then click Yes.

2 Select the replaced ink tank, then click OK.

Note ➤ When both black and color ink tanks have been replaced, select both 
Black and Color.

■ Resetting the ink counter from the printer driver setting screen

Note ➤ Do not reset the ink counter for an ink tank already in use.

Windows

1 Ensure that the printer is on, then open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click the Ink Counter Reset icon.

3 Select the ink tank you have just installed, then click Execute.
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1 Ensure that the printer is on, then open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

2 Click Utilities to open the Printer Utility dialog box.

3 Select Remaining ink level setting from the drop-down menu, then click 
Ink Counter Reset.

4 Select the ink tank you have just installed, then click Execute.
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How Low Ink Warning Setting Works

The low ink warning notifies you of low ink levels during printing. The Low Ink Warning has 
been preset to display automatically.

Note ➤ Refer to “Modifying the low ink warning setting” to change the setting if you 
do not want to display the Low Ink Warning.

■ What is Low Ink Warning?

Reset the ink counter for the ink tank installed.

When ink becomes low...

The low ink warning alerts.

When you install a new ink tank...

When you reset the ink counter, the counter will assume that the ink tank is full, regardless 
of how much ink actually remains. Resetting the counter on a new ink tank is the only way 
to match the counter value with the actual ink volume, so you should only enable the low ink 
warning and reset the ink counter when installing a new ink tank. 

➡ How to Display Low Ink Warning Correctly
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■ Low Ink Warning Display

The '!' shows a low ink level in the ink tank.

BJ Status Monitor (Windows)

BJ Status Dialog (Macintosh)

The color ink is 
low.

The color ink 
is low.



How Low Ink Warning Setting Works 79

Routine Maintenance

Macintosh

Note ➤ When background printing is enabled, the low ink warning displays on the 
BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ How to Display Low Ink Warning Correctly

• Reset the ink counter every time you install a new ink tank.
The ink counter is only accurate when synchronized with the actual ink level. 
To synchronize the counter with the actual ink level, the ink counter must be set only 
immediately after installing a new ink tank.

• Do not reset the ink counter for an ink tank in use.
 This would disrupt synchronization between the counter and the actual ink level.

Note ➤ • Ink counters for black and color ink tanks work independently of each 
other. However, both start counting at the time you enable the low ink 
warning. If you did not reset the counter for a specific ink tank when it was 
first installed, the low ink warning may not function correctly for that tank. 
Do not reset the ink counter until you install a new ink tank. Also note that 
the counter for each ink tank must be started separately. 

• Refer to "Low Ink Warning Displays Ink Tank with '?'" if the ink tanks and 
counters are not synchronized.
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■ Setting Low Ink Warning

Note ➤ Reset the ink counter every time you install a new ink tank. Otherwise, the 
ink level will not display correctly.

• Modifying the low ink warning setting

Windows

1 Ensure that the printer is on, then open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab, then click the Low Ink Warning Setting icon.

3 Modify the Display low ink warning and Display a confirmation 
message of ink tank replacement settings, then click Send.

Macintosh

1 Ensure that the printer is on, then open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... from the File menu.

2 Click Utilities to open the Printer Utility dialog box.
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3 Select Low Ink Warning from the drop-down menu, then click the 
Remaining ink level setting icon.

4 Modify the Display low ink warning and Display a confirmation 
message of ink tank replacement settings, then click Send.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects normally from the print 
head nozzles, and to verify print head alignment. Use this function when printed results are 
blurred or the color is incorrect.

Nozzle check pattern printing can be executed from the Windows and Macintosh printer 
drivers, or from the printer itself.

■ Printing the Nozzle Check Pattern from the Printer Drivers

Windows

1 With the printer on, load a sheet of plain letter-size or A4 paper in the 
printer.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Nozzle Check icon.

4 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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Macintosh

1 With the printer on, load a sheet of plain letter-size or A4 paper in the 
printer.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... from the File menu.

3 Click Utilities to open the Printer Utilities dialog box.

4 Select Test Print from the drop-down menu, then click the Nozzle Check 
icon.

5 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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■ Printing the Nozzle Check Pattern through the Printer

1 With the printer on, load a sheet of plain letter-size or A4 paper in the 
printer.

2 Hold the RESUME/CANCEL button down until the POWER lamp flashes 
twice.

➡ Examining the Nozzle Check Pattern
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■ Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly. 
Examine the nozzle check pattern output by the printer.

K

C

M

Y

Lines missing indicate the print 
head requires cleaning.

Unevenness in these patterns 
indicates the print head requires 
alignment.
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Print Head Cleaning

Clean the print head if you suspect that the nozzles might be clogged.
Print head cleaning can be performed either from the printer drivers or from the printer 
itself.

Note ➤ Cleaning the print head consumes ink, so perform print head cleaning only 
when necessary.

■ Cleaning the Print Head from the Printer Drivers

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Cleaning icon.
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4 Select the ink nozzles to be cleaned, then click Execute.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

5 When a confirmation message is displayed, click OK.

Macintosh

1 Ensure that the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

3 Click Utilities to open the Printer Utility dialog box.

4 Select Cleaning from the drop-down menu, then click the Cleaning icon.
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5 Select the ink nozzles to be cleaned, then click OK.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

■ Cleaning the Print Head from the Printer

This operation cleans all nozzles, both black and color. Because this method also resets the 
printer, any print data stored in the printer is lost.

1 Ensure the printer is on.

2 Press and hold the RESUME/CANCEL button until the POWER lamp 
flashes once.

The POWER lamp will start flashing as print head cleaning begins. Do not perform any 
other operations until the print head cleaning is complete. This takes about 50 seconds.
After print head cleaning finishes, print the nozzle check pattern to verify that the print head 
nozzles are clean.

➡ Printing the Nozzle Check Pattern
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Print Head Deep Cleaning

If print quality does not improve by standard print head cleaning, try deep cleaning, which is 
a more powerful process. Perform print head deep cleaning from the printer driver.

Note ➤ Print head deep cleaning consumes ink, so perform this procedure only 
when necessary.

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Deep Cleaning icon.

4 When the confirmation message is displayed, click OK.
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Macintosh

1 Ensure that the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

3 Click Utilities to open the Printer Utility dialog box.

4 Select Cleaning from the drop-down menu, then click the Deep Cleaning 
icon.

5 Click OK.

The POWER lamp will start flashing as print head deep cleaning begins. The process can 
take one or two minutes to complete, so wait until the POWER lamp stops flashing.
After print head deep cleaning finishes, print the nozzle check pattern to verify that the print 
head is clean. If not, perform print head deep cleaning once more. If the print head is still 
not clean after the second deep cleaning, the print head may be worn out, even if ink 
remains in the ink tanks. In this event, contact the Customer Care Center.

➡ Printing the Nozzle Check Pattern
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Transporting the Printer

Pack the printer carefully in its original packing materials.

If you do not have the original packing materials, pack the printer carefully and thoroughly in 
protective material inside of a sturdy box.

1 Turn the printer off.

2 After making sure that the POWER lamp is off, unplug the printer.

Important ➤ To protect the printer from damage, do not unplug the printer while the 
POWER lamp is lit or flashing.
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3 Remove the paper rest and the paper output tray.

4 Disconnect the printer cable from the computer and from the printer, then 
disconnect the power cord from the printer.
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5 Secure the printer with adhesive tape as shown, then pack it in a plastic 
bag.
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6 Attach protective material to both sides of the printer when packing the 
printer.

Clearly label the box as "Fragile" if using a transport company.
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• Compatible Media Types

• Envelopes

• High Resolution Paper

• Glossy Photo Paper

• High Gloss Photo Film

• Glossy Photo Cards

• Photo Paper Pro

• Photo Paper Pro for Borderless Printing

• Photo Paper Plus Glossy

• Matte Photo Paper

• Transparencies
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• T-Shirt Transfers

• Banner Paper
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Compatible Media Types

You can use the following types of paper and other media.

■ Size

• Standard paper: From A5 size (5.83 x 8.27 in. / 148.0 x 210.0 mm) to legal size (8.5 x 
14.0 in. / 215.9 x 355.6 mm)

• Non-standard paper: From 3.54 x 4.72 in to 8.5 x 23.0 in.
                                  (From 90.0 x 120.0 mm to 215.9 x 584.2 mm)

• Other: Envelopes (US Com. #10 and European DL)

Note ➤ Do not use the following types of paper. Using such paper will not only 
produce unsatisfactory results, but can also cause the printer to jam or 
malfunction.
• Folded, curled or wrinkled paper
• Wet paper
• Paper that is too thin *(less than 17 lb. / 64 g/m2)
• Paper that is too thick (more than 28 lb. / 105 g/m2)
• Picture postcards
• Postcards with an affixed photo or sticker
• Envelopes with a double flap
• Sealed envelopes
• Envelopes with an embossed or treated surface 
• Paper with holes (such as loose-leaf paper)
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*non-Canon brand paper

■ Weight

17 to 28 lb. (64 to 105 g/m2)
Do not use paper heavier than this (except for supported Canon-brand media), as it 
could jam in the printer.

■ Types

The following types of media can be used.
For more information about the media and the printing methods, refer to the specific 
sections.

Plain paper: Refer to the printed Quick Start Guide.

➡ Envelopes

➡ High Resolution Paper

➡ Glossy Photo Paper

➡ High Gloss Photo Film

➡ Glossy Photo Cards

➡ Photo Paper Pro

➡ Photo Paper Pro for Borderless Printing

➡ Photo Paper Plus Glossy
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➡ Matte Photo Paper

➡ Transparencies

➡ T-Shirt Transfers

➡ Banner Paper
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Envelopes

Use either US Com. #10 or European DL size envelopes.

■ Preparation for Printing

1 Press down on all four corners and edges of the envelopes to flatten them 
as shown below.

2 If the envelopes are curled, hold the opposite corners and gently bend 
them in the opposite direction.

Ensure that the flap of the envelope is perfectly straight.
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3 If the leading edge of an envelope is puffed up or curled, use a pen to press 
the envelope flat and sharpen the crease.

The envelopes may jam in the printer if they are not completely flat and the 
edges are not aligned.

Ensure that no curl or puff exceeds 0.1 in. (3 mm).

■ Unsuitable Envelopes

• Envelopes with an embossed or treated surface 
• Envelopes with a double flap or pressure seals

Press the envelope completely flat, 
working from the middle to the edge.

* The above illustrations show a side view of the leading edge of the 
envelope.
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■ Loading

• Place envelopes lengthwise with the flap to the left and the address side facing upward.
• Set the paper thickness lever to the right.
• Up to 10 envelopes can be loaded at once.

Note ➤ If the envelopes still do not feed properly even after removing curl, clean 
the paper feed roller.

1 Ensure that the printer is on, and that no paper is loaded in the printer.

2 Press and hold the RESUME/CANCEL button down, then release as 
the POWER lamp flashes three times.
The paper roller will rotate ten times as it cleans.
Repeat this three times.

Paper thickness lever
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3 Load a sheet of plain letter-size or A4 paper in the printer.

4 Press and hold the RESUME/CANCEL button down and release as the 
POWER lamp flashes three times to feed the sheet.
Repeat this three times.

If the printer still does not feed the envelopes through even after cleaning, 
repeat Step 4 again.

■ Printer Driver Settings

• Media Type: Envelope
• Page Size: Select either #10 Env. or DL Env. according to the envelope size you 

are using
• Orientation: Landscape

■ Handling of Printed Output

Remove each envelope as it is printed.

■ Printable Area

➡ Printing Area
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Printing Media

High Resolution Paper

This paper provides better color reproduction than plain paper. It is suitable for printing 
photographs and business documents that feature graphics.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• Do not load paper higher than the limit mark. A maximum of 80 sheets can be loaded.

Paper thickness lever

Print side
(whiter side)
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Printing Media

■ Printer Driver Settings

• Media Type: High Resolution Paper
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

Do not stack more than 50 sheets in the paper output tray. If the output paper is curled, it 
may prevent the next sheet from being ejected. In this case, or if the ink takes a long time 
to dry, remove each sheet as soon as it is printed.

■ Printable Area

➡ Printing Area
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Printing Media

Glossy Photo Paper 

This media is thicker than High Resolution Paper with a glossy printing surface to produce 
print-outs close to photograph quality.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• A maximum of 10 sheets can be loaded at once.
• When printing on Glossy Photo Paper, do not use any loading support sheet.

Paper thickness lever

Print side
(whiter side)
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Printing Media

■ Printer Driver Settings

• Media Type: Glossy Photo Paper
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Do not stack more than 10 sheets in the paper output tray.
• Do not touch the printed surface until the ink dries (approx. two minutes).

■ Printable Area

➡ Printing Area

Note ➤ For photographs and illustrations that you want to print with Borderless 
Printing, create the data by using the same size as the paper size, and 
paste the data so that it fills the editing screen without leaving any margins. 
If you are using an application that allows you to set margins, set the left, 
right, top and bottom margins to 0. For instructions on setting margins, refer 
to the user's manual for your application.
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Printing Media

High Gloss Photo Film 

This film has an extremely glossy surface, ideal for printing photographs with outstanding 
results.

■ Loading

• Load only one sheet at a time.
• Load the film with the cut corner at the upper right.
• If the film is curled, flatten it by curling in the opposite direction.
• Set the paper thickness lever to the left.

Paper thickness lever
Cut corner
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Printing Media

■ Printer Driver Settings

• Media Type: High Gloss Photo Film
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink is fixed.

■ Printable Area

➡ Printing Area
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Printing Media

Glossy Photo Cards

Made of the same material as Glossy Photo Paper, this photo-size paper is intended for 
printing images that cover the entire surface of the card, without a white border. When 
printing, use the original application software, Easy-PhotoPrint (for Windows) or 
ImageBrowser (for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.
• Do not use the loading support sheet provided with the package.

Paper thickness lever

Print side
(glossy side)
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Printing Media

■ Handling of Printed Output

• Do not stack more than 20 sheets in the paper output tray.
• Do not touch the printed surface until the ink is fixed (approx. two minutes).



Photo Paper Pro 112

Printing Media

Photo Paper Pro 

This is thick paper with a treated surface that enhances gloss and provides superior color 
reproduction. It is ideal for printing high quality photographs. This media is available in 
Letter, A4 and 4 x 6 sizes.

■ Loading

• Load only one sheet at a time.
• Load the paper with the glossier side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print side
(glossier side)
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Printing Media

■ Printer Driver Settings

• Media Type: Photo Paper Pro
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 
• Do not stack more than 20 sheets of 4 x 6 size paper in the output tray.
• Do not touch the printed surface until the ink is fixed (approx. 30 minutes).

Colors in dark images may appear indistinct at first, but become clearer after about 30 
minutes.

• Images may smudge if you place them in an album before the ink is completely dry. It is 
recommended that you allow the ink to dry for 24 hours.

• Do not attempt to dry the ink with a hair dryer or by exposing printed sheets to direct 
sunlight.

■ Storing Printed Output

• Do not store or display printouts in hot, damp or humid conditions.
Never expose them to heat or direct sunlight.

• Store printouts in photo albums, photo frames or presentation binders to protect them 
from direct exposure to air or sunlight.

• Do not mount printouts in an adhesive-type album, as you may not be able to remove 
them.
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Printing Media

• Be aware that some types of clear plastic folders and albums may cause the edges of 
the paper to turn yellow.

■ Printable Area

➡ Printing Area

Note ➤ For photographs and illustrations that you want to print with Borderless 
Printing, create the data by using the same size as the paper size, and 
paste the data so that it fills the editing screen without leaving any margins. 
If you are using an application that allows you to set margins, set the left, 
right, top and bottom margins to 0. For instructions on setting margins, refer 
to the user's manual for your application.
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Printing Media

Photo Paper Pro for Borderless Printing

Made of the same material as Photo Paper Pro, this photo-size paper is intended for 
printing images that cover the entire surface of the card, without a white border. When 
printing, use the original application software, Easy-PhotoPrint (for Windows) or ImageBrowser 
(for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.

Print side
(glossy side)

Paper thickness lever
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Printing Media

■ Handling of Printed Output

Follow the instructions described in "Photo Paper Pro".
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Printing Media

Photo Paper Plus Glossy

This is a thick paper with a glossy water-resistant coating and provides superior color 
reproduction. It is ideal for printing high-quality photographs. This media is available in 
letter, A4 and 4 x 6 sizes.

■ Loading

• Up to 10 sheets of letter-size or A4 paper can be loaded at once. 
Up to 20 sheets of 4 x 6 size paper can be loaded at once.

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.

Print side
(glossy side)

Paper thickness lever



Photo Paper Plus Glossy 118

Printing Media

■ Printer Driver Settings

• MediaType: Photo Paper Plus Glossy
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 
• Colors may change slightly if papers are stacked up before the ink is completely dry. It 

is recommended that you allow the ink to dry for 24 hours.
• Do not attempt to dry the ink with a hair dryer or by exposing printed sheets to direct 

sunlight.

■ Storing Printed Output

• Do not store or display printouts in hot, damp or humid conditions.
Never expose them to heat or direct sunlight.

• Store printouts in photo albums, photo frames or presentation binders to protect them 
from direct exposure to air or sunlight.

• Do not mount printouts in an adhesive-type album, as you may not be able to remove 
them.

• Be aware that some types of clear plastic folders and albums may cause the edges of 
the paper to turn yellow.
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Printing Media

■ Printable Area

➡ Printing Area

Note ➤ For photographs and illustrations that you want to print with Borderless 
Printing, create the data by using the same size as the paper size, and 
paste the data so that it fills the editing screen without leaving any margins. 
If you are using an application that allows you to set margins, set the left, 
right, top and bottom margins to 0. For instructions on setting margins, refer 
to the user's manual for your application.
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Printing Media

Matte Photo Paper

This is a thick matte paper with a water-resistant coating and provides superior color 
reproduction. It is ideal for a variety of printing such as paper crafts, calenders and matte 
photos. This media is available in letter and A4 sizes.

■ Loading

• Up to 10 sheets can be loaded at once. 
• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.

Print side
(glossy side)

Paper thickness lever
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Printing Media

■ Printer Driver Settings

• MediaType: Matte Photo Paper
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 

■ Printable Area

➡ Printing Area

Note ➤ For photographs and illustrations that you want to print with Borderless 
Printing, create the data by using the same size as the paper size, and 
paste the data so that it fills the editing screen without leaving any margins. 
If you are using an application that allows you to set margins, set the left, 
right, top and bottom margins to 0. For instructions on setting margins, refer 
to the user's manual for your application.
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Printing Media

Transparencies 

This film is ideal for printing presentation material for use with overhead projectors.

■ Loading

• Place one sheet of plain letter-size or A4 paper under the transparencies in the sheet 
feeder.

• Set the paper thickness lever to the left.
• A maximum of 30 sheets can be loaded at once.

Paper thickness lever

Plain paper

Transparencies
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Printing Media

• Although you can print on either side of Transparency media, best results can be 
obtained by printing on the side toward which it curls when held by the edge.

■ Printer Driver Settings

• Media Type: Transparency
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each transparency as soon as it is printed.
• Do not touch the printed surface until the ink dries (approx. 15 minutes).

■ Printable Area

➡ Printing Area

Print side
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Printing Media

T-Shirt Transfers 

This paper is used to produce iron-on transfers. The image is printed backward (mirror 
image) when the Media Type is set to T-Shirt Transfer in the printer driver.

Note ➤ For more information please see the instructions packaged with your media 
for proper loading and handling.

■ Loading

• Load only one sheet at a time.
• If the T-shirt transfer is curled, flatten it by curling it in the opposite direction.
• Load the paper with the side that does not have green lines facing up.
• Set the paper thickness lever to the right.

Paper thickness lever
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Printing Media

■ Printer Driver Settings

• Media Type: T-Shirt Transfer
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each T-shirt transfer as soon as it is printed.
• The T-shirt transfer should be used as soon as possible. Refer to the supplied 

instructions for details on how to use the paper.

■ Printable Area

➡ Printing Area
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Printing Media

Banner Paper

This is long paper that consists of consecutive sheets of letter-size or A4 paper, ideal for 
printing long posters or banners (up to six sheets long).

■ Preparation for Printing

• When tearing the banner paper, tear off one sheet more than you actually need to print.
• The maximum length for one print job is six sheets, so if you will be printing on six 

sheets, tear off a seven-sheet length.

■ Loading

1 Set the paper thickness lever to the right.

2 Load the banner paper with the printing side facing up. Gently fold the 
perforation between the first and second sheets.

Leave the rest of the paper folded up.
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Printing Media

3 Place the printer where the printed banner output can hang over the edge 
of the table.

Ensure that the ink does not stain the table or floor.
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Printing Media

■ Printer Driver Settings

• Media Type: Plain Paper
• Page Size: When using A4 banner paper: A4

When using letter size banner paper: Letter
• Printing Type: Banner Printing

On a Macintosh, before creating the document, select Banner 
Printing in the Page Setup dialog box.

• Copies: Must be set to 1 to print correctly. 

■ Printable Area

➡ Printing Area
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Troubleshooting

Troubleshooting

• Cannot Install the Printer Driver

• Print Quality is Poor or Contains Errors

• Printer Does Not Start or Stops During Print Jobs

• Paper Does Not Feed Properly or Paper Jams

• The POWER Lamp Flashes Orange

• An Error Message is Displayed on the Screen

• Have you replaced an ink tank with a new one? is Displayed

• Low Ink Warning Displays Ink Tank with '?'

• Problems Unique to Windows 

• Problems Unique to the Macintosh 

Windows

Macintosh
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Troubleshooting

Cannot Install the Printer Driver

■ Follow the installation procedure correctly.

Install the printer driver carefully, following the procedures described in the printed Quick 
Start Guide.

If the printer driver was not installed correctly, reinstall it. If you are using Windows, 
delete the printer driver before reinstalling it.

➡ Uninstalling Printer Drivers

Note ➤ If the Installer was forcibly terminated due to an error in Windows, Windows 
may be unstable. This will prevent the printer driver from being installed. 
Restart the computer before reinstalling the printer driver.

■ Close any other applications before installation.

Sometimes the printer driver cannot be installed because another application is running.
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Troubleshooting

■ If the Installer for the printer driver does not start up automatically 
when you insert the Setup Software & User’s Guide CD-ROM, open 
the My Computer window, then double-click the CD-ROM icon. 

Note ➤ If you choose to install from the Run command, you must specify the CD-
ROM drive letter and the installation program ("MSETUP.EXE"). The CD-
ROM drive letter is computer dependent.

■ Confirm that there are no problems with the Setup Software & User’s Guide 
CD-ROM.

In Windows, use Explorer to ensure that the CD-ROM can be read. In a Macintosh, 
check that the CD-ROM icon is visible. If there is a problem with the CD-ROM, contact 
the Customer Care Center.

Windows
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Troubleshooting

Print Quality is Poor or Contains Errors

• Cannot Print to End of Job

• Colors are Unclear

• Meaningless Characters or Symbols are Printed

• Printing is Blurred/Colors are Wrong

• Straight Lines are Misaligned

• Printed Paper Curls or Ink Blots

• Back of Paper is Smudged

• Printed Surface is Scratched

• White Streaks

• Colors are Uneven or Streaked
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Troubleshooting

Cannot Print to End of Job

■ Confirm that the Page Size setting matches the size of the paper loaded in the 
printer.

First, check the Page Size setting in the application.

Then check the Page Size setting in the Printer Properties dialog box for Windows, or 
the Page Setup dialog box for Macintosh.

■ Check the amount of the free space on the hard disk.

You may need to increase the amount of free space by deleting unnecessary files.
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Troubleshooting

Colors are Unclear

■ Confirm that the Media Type setting in the printer driver matches the type of paper 
loaded in the printer.

If you are printing a photograph or an illustration from a Windows environment, also 
increase Print Quality on the Main tab.
If you are working in a Macintosh environment, select the Photo or Graphic icon for 
the Print Mode in the Print dialog box.

■ Confirm the specified ink tank is installed.

When an ink tank runs out of ink, replace it with a new one.

Note ➤ Printed colors may not match screen colors perfectly due to basic 
differences in the methods used to produce colors. Color control settings 
and environmental differences can also affect how colors appear on the 
screen.
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Troubleshooting

Meaningless Characters or Symbols are Printed

■ If the problem only occurs when printing a specific document, try editing the 
document, then printing it.

If this does not resolve the situation, there may be a problem with your application 
program. 
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Troubleshooting

Printing is Blurred/Colors are Wrong

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the print head.

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

If the problem is not resolved after cleaning the print head several times, replace either of 
ink tanks. If print quality still remains poor, the print head may be worn out. Contact the 
Customer Care Center.

Note ➤ Always ensure that you dispose of the protective cap from a print head.

■ Ensure that you are printing on the correct side of the media.

You can only print on one side of certain media. 
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Troubleshooting

Straight Lines are Misaligned

■ Align the print head.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Print Head Alignment.

Follow the instructions on the screen.



Print Quality is Poor or Contains Errors 138

Troubleshooting

Macintosh

1 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

2 Click Utilities.

3 Select Test Print from the drop-down menu, then click Print Head 
Alignment.

Follow the instructions on the screen.

Note ➤ Straight lines can become misaligned if the paper thickness lever has been 
moved. Aligning the print head may also resolve this problem.
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Troubleshooting

■ In the printer driver settings, select a higher print quality setting.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then drag the Print Quality slider to the Fine end.
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Troubleshooting

Printed Paper Curls or Ink Blots

■ Use high resolution paper or photo paper to print images that require a lot of ink, 
such as pictures with intense colors, or photographs.

■ Reduce the Intensity setting in the printer driver and try printing again.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Color Adjustment, then click Set.

3 Drag the Intensity slider to adjust the intensity.
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Troubleshooting

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual, then click Details.

3 Click the Color icon, then drag the Intensity slider to set the intensity.
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Troubleshooting

Back of Paper is Smudged

■ If the next page prints before the ink is dry, enable the Pause Page printer driver 
setting.

You can either remove each printed sheet from the output tray as soon as it is printed, 
or adjust the Ink Drying Wait Time to pause after each sheet has printed.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Custom Settings to open the Custom Setting dialog box.

4 Drag the Ink Drying Wait Time slider, then click Send.
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Troubleshooting

Macintosh

1 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

2 Click Utilities.

3 Select Custom Settings from the drop-down menu.

4 Drag the Ink Drying Wait Time slider, then click Send.

■ You may need to clean some of the printer’s internal parts. To clean the inside of 
the printer, follow the procedure below.

1 Load several sheets of letter-size or A4 plain paper into the printer’s paper 
feeder.

2 Press and hold the RESUME/CANCEL button until the POWER lamp 
flashes three times, then release the button.

3 Repeat this operation until there are no more smudges on the test page.
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Troubleshooting

Printed Surface is Scratched

■ Ensure that you are using suitable paper.

• The paper weight must be less than 28 lb. (105 g/m2).

If you use non-Canon brand paper heavier than 28 lb. (105 g/m2), the print head may 
scratch the printed surface.
Clean the print head first and print with the correct paper.

• The paper must not be curled.

This problem can be resolved by turning the paper over.

• Before starting Borderless Printing, check the paper that you are using.

With Borderless Printing, the print quality may decrease or smudging may occur at the 
top and bottom edges of the paper. Use Photo Paper Pro, Glossy Photo Paper, Photo 
Paper Plus Glossy or Matte Photo Paper.  If smudging still occurs, set the paper 
thickness lever to the right and try printing again.

■ When printing on thick paper, set the paper thickness lever to the right.

This widens a gap between the print head and the paper. If the paper is scratched even 
when printing on plain paper, also try this. A message will display saying that the position 
of the lever is incorrect. Ignore the message and continue printing. 
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Troubleshooting

■ Reduce the Intensity setting in the printer driver and try printing again.

When printing an image with high intensity, especially on plain paper, the paper may 
absorb too much ink and become wavy. This may cause the printed surface to become 
scratched.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Color Adjustment, then click Set.

3 Drag the Intensity slider to adjust the intensity.
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Troubleshooting

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual, then click Details.

3 Click the Color icon and drag the Intensity slider to set the intensity.

■ Ensure you are printing within the recommended printing area.

➡  Printing Area
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Troubleshooting

White Streaks

■ Print the nozzle check pattern to check the ink output.

If a specific color does not print in the nozzle check pattern, clean the print head.

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

The problem can also be resolved by aligning the print head. For details on print head 
alignment, refer to "Straight Lines are Misaligned".
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Troubleshooting

Colors are Uneven or Streaked

■ Increase the print quality setting in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then drag the Print Quality slider to the Fine end.
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Troubleshooting

■ Set the halftoning method to Diffusion in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Custom for the Print Quality setting, then click 
Set.

3 Click Diffusion for the Halftoning setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then click Diffusion for the Halftoning setting.
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Troubleshooting

Printer Does Not Start or Stops During Print Jobs

• Printing Does Not Start

• Printing Stops Before It is Completed

• Printer Moves But Does Not Print

• Print Head Holder Does Not Move
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Troubleshooting

Printing Does Not Start

■ Ensure that the printer is turned on.

If the POWER lamp is off, press the POWER button.
If the POWER lamp is flashing green, the printer is initializing. Wait until the POWER 
lamp stops flashing.

Note ➤ When printing a large amount of data, such as a photographs or 
illustrations, the printer may take longer than usual to begin printing. While 
the POWER lamp is flashing, the computer is processing the data and 
sending it to the printer. Wait until the green lamp stops flashing and 
printing begins.

■ Ensure that the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove and reconnect the 
printer directly to the computer. Try printing again.
If printing is now successful, there may be a problem with the device.
Also there could be a problem with the cable(s). Replace the cable(s) and 
try printing again.
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Troubleshooting

■ Ensure that the correct printer driver is selected.

In Windows, ensure that Canon S330 is selected in the Print dialog box.
In Macintosh, ensure that S330 is selected in the Chooser.

Note ➤ In Windows, you can set the Canon S330 as the default printer.

■ Ensure that the printer port is set correctly. 

Set "USBPRNnn" or "USBnnn" ("n" represents a number) as the printer port.

1 Click Start, then Settings, then Printers.

2 Select the Canon S330 icon.

3 Open the File menu and select Properties.

4 Click the Details tab (or Ports tab) and set the printer port.

Windows
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Troubleshooting

Printing Stops Before It is Completed

■ Check the status of the POWER lamp.

When the POWER lamp is flashing green, the printer is processing data. Printing a large 
amount of data, such as a photos or graphics, takes time for the computer to process the 
data, during which the printer may appear to not be functioning.

In addition, when continuously printing material that uses a large amount of black ink on 
plain paper, the printer will sometimes pause. In either case, wait until the processing is 
complete.

■ Halt the print job and turn the printer off for at least 15 minutes to cool the print 
head down.

The print head can overheat when continuously printing for long time. To protect the print 
head, the printer will sometimes pause automatically at a line break before resuming.
In this event, interrupt the print job at a convenient time and turn the printer off for at least 
15 minutes.

Furthermore, when continuously printing graphics or photos with intense colors, printing 
may stop to protect the print head. In this case, printing will not resume. Turn the printer 
off and wait at least 15 minutes before turning the printer on again.

Caution ➤ The area around the print head inside the printer can become extremely 
hot. Do not touch the print head or nearby components.
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Troubleshooting

Printer Moves But Does Not Print

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the print head.

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

If the problem is not resolved by cleaning the print head several times, replace either of 
ink tanks. If print quality still remains poor, the print head may be worn out. Contact the 
Customer Care Center.
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Troubleshooting

Print Head Holder Does Not Move

■ Ensure that the printer is turned on.

The print head holder will not move unless the power is on. If the POWER lamp is off, 
close the front cover and turn the power on.

If the POWER lamp is flashing green, the printer is initializing.
When the POWER lamp stops flashing, open the front cover again.

■ If the front cover has been left open for a while, close and reopen it.

If the front cover is left open for more than 10 minutes, the print head holder moves to the 
right to prevent the print head from drying out. Close and reopen the front cover to return 
the holder to the center position.
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Troubleshooting

Paper Does Not Feed Properly or Paper Jams

• Paper Does Not Feed Properly

• Envelopes or Postcards Do Not Feed Properly

• Paper Jams
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Troubleshooting

Paper Does Not Feed Properly

■ Confirm the paper conditions.

• If non-Canon brand media, the paper is not too thick (less than 28 lb. / 105g/m2).

• The number of sheets loaded does not exceed the recommended level.

• The paper is not creased, curled or wrinkled.

➡ Compatible Media Types

■ Ensure that the left edge of the paper touches the paper guide.

■ When printing envelopes, refer to "Envelopes" in "Printing Media" and prepare the 
envelopes before printing.

Once you have prepared the envelopes, load them in the printer in portrait orientation. If 
the envelopes are placed in landscape orientation, they may not feed properly.

■ When using transparencies, load one sheet of plain paper in the printer first, then 
place the transparencies on top of it.

The last transparency may not feed properly unless there is a sheet of plain paper 
beneath it.
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Troubleshooting

Envelopes or Postcards Do Not Feed Properly

If envelopes or postcards do not feed properly even after removing curl, clean the paper 
feed roller.

1 Ensure that the printer is on and no paper is loaded in the printer.

2 Press and hold the RESUME/CANCEL button down, then it release when 
the POWER lamp flashes three times.

The paper roller will rotate ten times as it cleans.

Repeat this three times.

3 Load a sheet of letter-size or A4 plain paper in the printer.

4 Press and hold the RESUME/CANCEL button down, then it release when 
the POWER lamp flashes three times. The sheet will feed through.

Repeat this three times.

If the printer still does not feed the envelopes or the postcards through after cleaning, 
repeat these procedures again.
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Troubleshooting

Paper Jams

Remove the paper according to the following procedure.

1 Slowly pull the paper out, either from the sheet feeder or from the paper 
output slot, whichever is easier.

If the paper tears and a piece remains inside the printer, open the front 
cover and remove it. 

If you cannot pull the paper out, turn the printer off and turn it back on. The 
paper will be ejected automatically.

2 After removing all paper, close the front cover.

3 Reload the paper into the printer and press the RESUME/CANCEL button.

Note ➤ When reloading the paper into the printer, refer to "Paper Does Not Feed 
Properly" to confirm that you are using the correct paper and are loading it 
into the printer correctly.
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Troubleshooting

The POWER Lamp Flashes Orange

An error has occurred in the printer. The number of orange flashes between green flashes 
indicates the type of error, as outlined below. Check the cause and take the appropriate 
action.

■ Two flashes: Out of paper, paper jam or paper feed error

Replace the paper correctly and press the RESUME/CANCEL button.
If paper has jammed in the printer, clear the jam and press the RESUME/CANCEL 
button.

■ Three flashes: Paper jam

If paper has jammed in the printer, clear the jam, replace the paper in the printer correctly 
and press the RESUME/CANCEL button.

➡ Paper Jams
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Troubleshooting

■ Six flashes: No print head installed

Install a print head.

■ Seven flashes: Defective print head

Contact the Customer Care Center.

■ Eight flashes: Waste ink tank almost full

The printer has a built-in waste ink tank for the ink used during print head cleaning. Eight 
flashes indicates that the waste ink tank is nearly full. Press the RESUME/CANCEL 
button to cancel the error so you can continue printing. Before the waste ink tank 
becomes completely full, contact the Customer Care Center to have the waste ink tank 
replaced.

Note ➤ Canon recommends that you call the Customer Care Center for service as 
soon as this error occurs. Once the waste ink tank becomes completely full, 
printing will be no longer possible.
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Troubleshooting

■ POWER lamp flashes alternate green and orange: 
An error has occurred that may require you to contact the Customer Care Center.

Turn the printer off and unplug it from the power supply. Plug the printer back in and turn 
it back on. If the problem remains, contact the Customer Care Center.
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Troubleshooting

An Error Message is Displayed on the Screen

• Error Writing to USBxxx 

• Application Error or General Protection Fault 

• Other Error Messages 

• Other Error Messages 

Windows

Windows

Windows

Macintosh
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Troubleshooting

Error Writing to USBxxx 

■ Ensure that the printer is turned on.

If the POWER lamp is off, turn the printer on.
If the POWER lamp is flashing green, the printer is initializing. Wait until the POWER 
lamp stops flashing.

■ Ensure that the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove and reconnect the 
printer directly to the computer, then try printing again.
If printing is now successful, there may be a problem with the device.
Also there could be a problem with the cable(s). Replace the cable(s) and 
try printing again.

■ If spooling is enabled, disable it to send the print data directly to the printer and try 
printing again.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

Windows
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Troubleshooting

2 Click the Details tab, then Spool Settings, then select Print directly to 
the printer.
In Windows 2000 or Windows XP, click the Advanced tab, then click Print 
directly to the printer.

■ Verify the USB port status.

1 Right-click My Computer, then select Properties.

2 On the Device Manager tab, double-click Universal serial bus controller, 
then double-click Canon S330.
In Windows 2000 or Windows XP, click the Hardware tab, then click Device 
Manager. Double-click Universal Serial Bus controller, then double-click 
USB Printing Support.This will open the General tab.

3 On the General tab, check if there is any indication of a problem with the 
device.

Also refer to the Troubleshooting section of the printed Quick Start Guide.

■ Ensure that the printer port setting corresponds to the printer interface 
connection.

1 Open the Printer Properties dialog box from the Start menu.
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Troubleshooting

➡ Opening the Printer Properties dialog box directly from the Start 

menu

2 Click the Details tab (or Ports tab), then select USBPRNnn (Canon S330) 
or USBnnn (Canon S330) ("n" represents a number) from the Print to the 
following port drop-down list.

■ There may be a problem in the printer driver. Uninstall the printer driver and 
reinstall it.

➡ Uninstalling Printer Drivers

Also refer to the Troubleshooting section of the printed Quick Start Guide.
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Troubleshooting

Application Error or General Protection Fault

■ Ensure that the application program you are using is intended for your operating 
system.

For example, if you attempt to print with a Windows 3.1 application under Windows 98, 
the application may not function correctly and an error may occur.
Use an application program intended for your operating system.

■ If other applications are running, close them to increase available memory, then 
try printing again.

■ Ensure that enough memory is allocated to the application.

Refer to the memory requirements of your application.

Windows
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Troubleshooting

■ Check the amount of free space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.

■ If the problem only occurs when printing a specific document, try editing the 
document, then printing it.

If this resolves the problem, there may have been a problem in the original document. If 
the same problem occurs with the edited document, contact the manufacturer of your 
application.

■ There may be a problem with the printer driver. Uninstall the printer driver and 
reinstall it.

Also refer to the Troubleshooting section of the printed Quick Start Guide.

➡ Uninstalling Printer Drivers
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Troubleshooting

Other Error Messages 

■ If the BJ Status Monitor is displayed, follow the instructions on screen.

If an error occurs during printing, the BJ Status Monitor displays the error on the Printer 
Status tab. Follow the instructions on screen.

In Windows 98 or Windows Me, click the Guide tab for actions to be taken in response to 
the error.

Refer to "Low Ink Warning Displays Ink Tank with '?'" for more information.

Windows
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Troubleshooting

■ If one of the following messages is displayed outside of the BJ Status Monitor:

Could not spool successfully due to insufficient disk space
Increase the amount of free space on the disk by deleting unnecessary files.

Could not spool successfully due to insufficient memory
Increase available memory by closing any other applications currently running.

Printer driver could not be found
Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers

Background printing failed (Windows 98/Windows Me only)
Restart Windows and try printing again.

Could not print Application name – File name
Try printing again once the current job is finished.
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Troubleshooting

Other Error Messages 

■ If a message with the format "Error No.: Xn" (where "X" represents a letter and "n" 
represents a number) is displayed:

Error No.: X202
Not enough memory for printing. Increase available memory by closing any other 
applications currently running.

Error No.: X203
There is a problem with the printer driver. Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers
Error No.: X300
Ensure that the power is on, and that the printer and the computer are securely 
connected. If the problem remains, verify the Chooser setting.

1 In the Apple menu, select Chooser.

2 Click the S330 icon and ensure that S330 is selected as the connected 
destination.

If it is not selected, select it.

If the problem remains, delete all unnecessary documents from the Extensions and 
Control Panels folder.

Macintosh
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Troubleshooting

Have you replaced an ink tank with a new one? is 
Displayed

If the front cover has been open for a certain period, a confirmation message of ink tank 
replacement may be displayed before the next print job.

■ If the ink tank has been replaced with a new one:

Click Yes to reset the ink counter.

■ If the front cover has been open for a while (the ink tank has not been replaced):

Click No to close the dialog box.

■ You can choose to disable the display of a confirmation message.

➡ Modifying the low ink warning setting
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Troubleshooting

Low Ink Warning Displays Ink Tank with '?'

The ink level of an ink tank displayed with a '?' is not synchronized with its ink counter.

BJ Status Monitor (Windows)

BJ Status Dialog (Macintosh)

The color ink level 
may not be 
correctly 
displayed.

The color ink level 
may not be 
correctly 
displayed.
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Troubleshooting

Macintosh

Note ➤ When background printing is enabled, the low ink warning displays on the 
BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ Reset the ink counter from the printer driver when you replace the ink tank.

➡ Resetting the ink counter from the printer driver setting screen

Note ➤ When Display a confirmation message of ink tank replacement is 
selected, a message asking whether or not the ink tank has been replaced 
is displayed automatically whenever the ink tank is replaced.

➡ Modifying the low ink warning setting

■ Turn the low ink warning off until you replace the ink tank to stop the warning 
message.

Windows

1 Ensure that the printer is on and open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box
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Troubleshooting

2 On the Maintenance tab, click the Low Ink Warning Setting icon.

3 Clear the check box for Display low ink warning, then click Send.

Macintosh

1 Ensure that the printer is on, then open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page 
Setup... in the File menu.

2 Click Utilities to open the Printer Utilities dialog box.

3 Select Remaining ink level setting from the drop-down menu and click 
the Low Ink Warning Setting icon.

4 Clear the Display low ink warning check box, then click Send.

Note ➤ Also refer to "How Low Ink Warning Setting Works" to display the ink level 
correctly.
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Troubleshooting

Problems Unique to Windows

• The BJ Status Monitor is Not Displayed

• Cannot Print in Background (Windows 98/Windows Me only)

Windows



Problems Unique to Windows 177

Troubleshooting

The BJ Status Monitor is Not Displayed

■ Ensure that "Enable bi-directional support for this printer" is selected.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

2 On the Details tab, click Spool Settings, then select Enable bi-
directional support for this printer.

In Windows 2000 or Windows XP, select Enable bi-directional support on 
the Ports tab.
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Troubleshooting

Cannot Print in Background (Windows 98/Windows Me 
only)

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may need to delete 
unnecessary files, or disable background printing.

■ Ensure that background printing is enabled.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Page Setup tab, click Printer control... then select Background 
Printing.
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Troubleshooting

Problems Unique to the Macintosh

• Jagged Text or Graphics, or Banded Gradations

• Cannot Print in Background

Macintosh
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Troubleshooting

Jagged Text or Graphics, or Banded Gradations

■ Ensure that your application supports Quick Draw.

If you are using a PostScript-compatible application, printed text and lines may appear 
jagged and gradations may appear banded. As the S330 is not a PostScript printer but a 
Quick Draw printer, use an application compatible with Quick Draw for printing.
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Troubleshooting

Cannot Print in Background

■ Ensure that background printing is enabled.

1 In the Apple menu, select Chooser.

2 Click Backgrounding on.

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space.
You may need to remove unnecessary files, or disable background printing.
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Specifications

Specifications

Printing method:
Bubble Jet on-demand

Printing resolution:
2400 (horizontal) × 1200 (vertical) dpi. max.

Print speed (printing with Canon standard pattern):
Black printing Draft: 14 ppm

Standard: 10.5 ppm
Color printing Draft: 10 ppm

Standard: 4.7 ppm

Print direction:
Bi-directional

Print width:
8.0 in. (203.2 mm) max.
(for borderless printing: 8.5 in./216.0 mm)

Resident print control mode:
Canon extended mode
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Specifications

Receive buffer:
56 KB

Interface:
USB 2.0-compatible 

Interface connector:
USB standard Series B receptacle (USB interface)

Recommended printer cable:
Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type: Twisted-pair shielded cable
Length: Up to 16.4 ft. (5.0 m)
Connectors: USB standard Series B pluggable

Acoustic noise level:
Approx. 45 dB (A) (in the highest print quality mode)

Operating environment:
Temperature: 41 to 95°F (5 to 35°C)
Humidity: 10 to 90%RH (no condensation)

Storage environment:
Temperature: 32 to 95°F (0 to 35°C)
Humidity: 5 to 90% RH (no condensation)

Power supply:
USA/Canada AC 120 V, 60 Hz
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Specifications

Europe AC 230 V±10%, 50 Hz
Australia AC 240 V, 50 Hz

Power consumption:
Standby: Approx. 2 W
Printing: Approx. 30 W

Dimensions (without a paper rest and paper output tray):
15.35 (W) × 9.76 (D) × 7.28 (H) in
390 (W) × 248 (D) × 185 (H) mm

Weight:
Approx. 7.48 lb. (3.4 kg)
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Specifications

■ Feed method:

Continuous feed through auto sheet feeder
For Plain Paper, Envelopes, High Resolution Paper, 
Glossy Photo Paper, High Gloss Photo Film, 
Glossy Photo Cards, Photo Paper Pro, 
Photo Paper Plus Glossy, Matte Photo Paper, 
Transparencies, T-shirt Transfers, Banner Paper

■ Sheet feeder capacity:

Plain Paper (17 lb./75 gsm) 100 sheets max.
High Resolution Paper 80 sheets max.
Envelopes 10 pieces max.
Glossy Photo Paper 10 sheets max.
High Gloss Photo Film 1 sheet
Glossy Photo Cards 20 sheets max.
Photo Paper Pro 1 sheet (A4/Letter) 20 sheets max. (4x6)
Photo Paper Pro for 
Borderless Printing 20 sheets max.

Photo Paper Plus Glossy 10 sheets max. (A4/Letter) 20 sheets max. (4x6)
Matte Photo Paper 10 sheets max. 
Transparencies 30 sheets max.
T-Shirt Transfers 1 sheet
Banner Paper 1 sheet
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Specifications

■ Ordinary print media:

Regular size: Letter, legal, A4, A5, B5, US Com.#10, European DL

Custom size: width: 3.54 to 8.5 in. (90.0 to 215.9 mm)
height: 4.72 to 23.0 in. (120.0 to 584.2mm)

Weight: 17 to 28 lb. (64 to 105 g/m2)

Canon Special media:
High Resolution Paper HR-101N
Glossy Photo Paper GP-301N/GP-301
High Gloss Photo Film HG-201
Glossy Photo Cards FM-101
Photo Paper Pro PR-101
Photo Paper Pro PC-101S
Photo Paper Plus Glossy PP-101
Matte Photo Paper MP-101 
Transparencies CF-102
T-Shirt Transfers TR-201
Banner Paper
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Specifications

■ Graphic image printing:

Data format: Canon extended mode: Raster image format

Resolution: Canon extended mode: 300, 600, 1200, 2400 dpi

■ Print Head:

Black: 320 nozzles (600 dpi)

Cyan, Magenta, Yellow: 128 nozzles per each color (600 dpi)

■ Ink Tanks:

Capacity:
Black (BCI-24 Black) approx. 300*1, approx. 580*2

Color (BCI-24 Color) approx. 170*2

*1 1500 characters per page, normal text, at standard and plain paper mode with 
Windows 98/Windows Me

*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and plain paper 
mode with Windows 98/Windows Me
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Specifications

■ Printer driver operating environment:

IBM PC/AT-compatible computer running on Windows 98, Windows Me, Windows 
2000, Windows XP or Macintosh computers with USB interface running on Mac OS 
8.6 - Mac OS 9.X

■ Hard disk space:

Approx. 15 MB to install on Windows 98 and Windows Me, 30 MB on Mac OS 8.6-
Mac OS 9.X, or approx. 25 MB on Windows 2000 and Windows XP (including 
temporary files)

Note ➤ Use the system under the following operating environment.

Windows Computer with Microsoft Windows 98, Windows Me, Windows 2000 or 
Windows XP which is preinstalled by a computer manufacturer on 
purchase. (USB port operation also needs to be assured by the 
manufacturer.)

Macintosh Macintosh computers with USB and Mac OS 8.6 - Mac OS 9.X, which is 
preinstalled by a computer manufacturer on purchase.

Specifications subject to change without prior notice.
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Specifications

■ Printing Area

To ensure the best print quality, the printer allows a margin along each edge of 
media. 

Printing area (dark blue): Canon recommends that you print within this area.  
( )

Printable area (light blue): The area where it is possible to print. However, printing 
in this area can adversely affect the print quality or the 
paper feed precision. ( )

➡ A4, B5, A5, 4" x 6"

➡ Letter, Legal

➡ Envelopes

➡ Banner Paper
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Specifications

A4, B5, A5, 4" x 6"

Note ➤ When printing on Photo Paper Pro, Glossy Photo Paper, Photo Paper Plus 
Glossy and Matte Photo Paper, selection of "Borderless Printing" enables 
you to make prints with no margins.
However, borderless printing may cause the top and bottom edges of 
paper to decrease in print quality or smeared.

Size Printable Area (width x height)

A4 8.0 × 11.4 in. (203.2 × 289.0 mm) 

B5 6.9 × 9.8 in. (175.2 × 249.0 mm) 

A5 5.6 × 7.9 in. (141.2 × 202.0 mm)

4" x 6" 5.6 × 7.9 in. (94.8 × 144.4 mm)
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Specifications

Recommended printing area

Printable area

1.1 in. 

1.04 in. 

0.13 in. 0.13 in.

0.2 in.

0.12 in. 
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Specifications

Letter, Legal

Note ➤ When printing on Photo Paper Pro, Glossy Photo Paper, Photo Paper Plus 
Glossy and Matte Photo Paper, selection of "Borderless Printing" enables 
you to make prints with no margins.
However, borderless printing may cause the top and bottom edges of 
paper to decrease in print quality or smeared.

Size Printable Area (width x height)

Letter 8.0 × 10.7 in. (203.2 × 271.4 mm)

Legal 8.0 × 13.7 in. (203.2 × 347.6 mm)

1.1 in.

1.04 in.

0.25 in. 0.25 in.

0.2 in.

0.12 in.

Recommended printing area

Printable area
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Specifications

Envelopes

Size Printable Area (width x height)

European DL 7.5 × 4.1 in. (190.5 × 103.2 mm)

US Com. #10 8.3 × 3.9 in. (211.8 × 98.0 mm)

0.12 in. 1.04 in.

0.13 in.

0.13 in.

Printable area
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Specifications

Banner Paper

Size Printable Area (width x height)

Banner Paper A4: 8.0 × 69.8 in. (203.2 × 1774.0 mm)

Letter: 8.0 × 65.7 in. (203.2 × 1668.4 
mm) 

0.13 in.

0.13 in.

0.12 in.
1.1 in. 0.2 in.

Max. 6 sheets
Min. 2 sheets

Recommended printing area

Printable area
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Index

A
Amount of Extension 27
Application Error 167

B
Background printing (Macintosh) 59
Background printing (Windows) 178
Banner Paper 126
BCI-24 Black 69
BCI-24 Color 69
BJ Print Monitor (Macintosh) 59
BJ Status Dialog (Macintosh) 78, 173
BJ Status Monitor (Macintosh) 65
BJ Status Monitor (Windows) 37, 78, 169, 173, 177
Booklet Printing 26
Borderless Printing 45

C
Canceling a Print Job (Macintosh) 61
Canceling a Print Job (Windows) 40
Chooser (Macintosh) 59

Index
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Index

Cleaning 34, 46, 86
Client (Macintosh) 63
Compatible Media Types 97

D
Deep Cleaning 34, 89
Duplex Printing 27, 57

E
Enabling Low Ink Warning 77
Envelopes 100
Error Message 163, 169, 171

F
Fit to Page Printing 26, 57
Front cover 15, 155

G
Gamma Correction (Macintosh) 55
General Protection Fault 167
Glossy Photo Cards 110
Glossy Photo Paper 106

H
High Gloss Photo Film 108
High Resolution Paper 104
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Index

I
Ink Counter Reset 35, 75
Ink Tank 68, 69

L
Low Ink Warning 35, 77
Low Ink Warning Displays Ink Tank with '?' 173

M
Matte Photo Paper 120
Media Type (Macintosh) 48
Media Type (Windows) 23

N
Network (Macintosh) 62
Nozzle Check Pattern 85

O
Opening the Printer Properties Dialog Box (Windows) 20

P
Page Setup Dialog Box (Macintosh) 44
Page Size (Windows) 25
paper feed roller 102, 158
Paper Guide 15
Paper Jams 159
Paper Output Tray 15
Paper Rest 15
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Index

Paper Size (Macintosh) 44
Paper Thickness Lever 17
Photo Optimizer PRO (Macintosh) 53
Photo Optimizer PRO (Windows) 31
Photo Paper Plus Glossy 117
Photo Paper Pro 112
Photo Paper Pro for Borderless Printing 115
PICT File (Macintosh) 57
Poster 57
Poster Printing 26
POWER Button 18
POWER Lamp 18, 160
Preview before printing 24
Print Advisor (Windows) 24
Print Dialog Box (Macintosh) 48
Print Head Holder 17
Print Head Lock Lever 17
Print Mode (Macintosh) 49
Print server (Macintosh) 62
Printable area 189
Printer Driver (Macintosh) 42
Printer Driver (Windows) 19
Printer port 165
Printer Properties Dialog Box (Windows) 20, 22
Printing Area 189
Printing the Nozzle Check Pattern 82
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R
Replacing an Ink Tank 69
RESUME/CANCEL Button 18

S
Sheet Feeder 15
Simulate illustration (Macintosh) 52
Simulate Illustration (Windows) 30
Specifications 182

T
Transparencies 122
Transporting the Printer 91
T-Shirt Transfers 124

U
Uninstalling Printer Drivers (Macintosh) 66
Uninstalling Printer Drivers (Windows) 41
USB Port 16, 165

V
Vivid Photo 31, 53

W
When to Replace Ink Tank and Maintain Print Head 68
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